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Need Help Taming Your Paper Monster?

You’re in the right place!

Neat for Mac Help aims to
have you turning receipts,
business cards and
documents into organized
digital files as quickly and
effortlessly as possible.

This digital filing cabinet is
a place to track and
manage all your
information and transform
it into actionable, usable
information—without the
paper or the headache! 

The Paper Monster!

In this section:
Where to Start



2 Chapter 1 Welcome to Neat for Mac Help

1Welcome to Neat for Mac Help

Where to Start

We know you don’t have all day to read our Help files (as scintillating as they might appear). So
let’s get you on the right path ASAP. In the table below, follow the path that best corresponds to
your technical savvy and current Neat for Mac know-how.

How Tech Savvy are you?

Very Tech Savvy  Not So Tech Savvy

YES

I’ve Used 

a

Previous

Version

of 

Neat

Start here:

Organizing Your Items:
Libraries, Cabinet, Folders &
Subfolders

After that:

NeatCloud

Start here:

Getting Started with Neat for Mac

The Neat for Mac Interface

After that:

Getting Items Into Neat for Mac

Organizing Your Items: Libraries,
Cabinet, Folders & Subfolders

Working with Your Items

Exporting, Reporting and Printing

NO

I’ve

Never 

Used

Neat

Start here:

Getting Started with Neat for
Mac

After that:

Getting Items Into Neat for
Mac

Organizing Your Items:
Libraries, Cabinet, Folders &
Subfolders

Working with Your Items

Exporting, Reporting and
Printing

NeatCloud

Start here:

Getting Started with Neat for Mac

The Neat for Mac Interface

After that:

Getting Items Into Neat for Mac

Organizing Your Items: Libraries,
Cabinet, Folders & Subfolders

Working with Your Items

Exporting, Reporting and Printing
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What’s In It for You?

At The Neat Company, we believe you shouldn’t have to work hard to use your information. 

That’s why we’ve developed a flexible system of intelligent solutions that transform information—
taking it from paper to digital, cluttered to organized, single use to multi-tasking, static to
dynamic. 

Simply put, we transform information—any kind of information—into something that works for you.
From business cards and receipts to tax documents and recipes and even your child’s art
collection, we free the information that’s trapped in your documents—so you can organize, store,
secure, and activate it. 

Because when your information is transformed, you are too— from cluttered to confident, from
overwhelmed to accomplished. 

In this section:
Top 10 Common Tasks in Neat for Mac

User Case Studies
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Top 10 Common Tasks

The table below contains links to ten of the most common tasks performed in Neat. 

# Task & Link Description/Benefit

1 Creating a PDF file Scan a document directly to a PDF file that can be
shared via email

2 Scanning receipts Scan a receipt and capture key information in the
Neat for Mac database

3 Creating an Expense Report Create a report to track business expenses

4 Exporting Data Export expense data to a variety of formats including
Quicken, CSV, spreadsheet, PDF and image formats.

5 Scanning bank statements, bills,
credit card statements

Scan bank statements, bills credit card statements
and other such documents and capture key
information in the Neat for Mac database

6 Syncing to NeatCloud Synchronize to the NeatCloud and access your data
from anywhere.

7 Organizing Personal Docs
(Recipes, Articles, Warranties)

Scan the documents you use most so save clutter

8 Creating a Tax Reports Create a tax report to maximize your tax savings

9 Print to Neat for Mac Use the Neat printer driver to print from other
applications (e.g. web browsers, email clients, word
processing) directly into Neat for Mac. 

10 Splitting a Receipt If a receipt contains multiple items that need to be
expensed to more than one client or project, you can
split a receipt across multiple folders. 

User Case Studies

Wondering how to make the best use of Neat for Mac? Here are a few scenarios of how others
use Neat:

The Business User

Scan and organize receipts, bills, invoices and checks

Scan business cards to create an organized contact list

Sync contacts with Outlook

Create expense reports
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Scan and store business contracts and other legal documents

Create PDFs of documents to share (no more faxing!)

Search for any detail in the cabinet

The Home User

Track family expenses

Manage health documents and medical records

Scan and organize recipes

Scan and organize receipts for tax purposes

Create tax reports

Organize warranties and instructions for appliances

Maintain records of purchases for insurance purposes

Organize children’s school documents, report cards or assignments

Search for any detail in the cabinet

The Traveling User

Use the mobile scanner during airport downtime to catch up on organizing

Create expense reports

Scan business cards to create an organized contact list

Sync contacts with Address Book 

Scan and organize receipts, bills and checks

Scan and store sales contracts

Create and PDFs of documents to share (no more faxing!)

Search for any detail in the cabinet
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Try It: Your First Scan

These instructions assume that Neat for Mac is installed and the scanner is properly attached to
your computer. 

Scanning and Reviewing Your First Item

SCANNING

1. In the Folder Navigation pane, click on a folder. (This is where your scanned item will be
saved. You also have the option of creating a new folder.) 

2. Place the item to be scanned in the scanner as follows:

Mobile Scanner

Face down (text facing away from you)

Aligned at the far right front edge (under the PDF and Scan buttons)

TIP: The mobile scanner will lightly grab the item when it is placed in the proper
position.
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Desktop Scanner

Face up (text facing you)

In the appropriate tray of the Desktop Scanner (documents in the back, receipts in the
middle, business cards in the front)

3. Do either of the following:

Press the Scan button on the scanner

Click the Scan button in Neat for Mac

The processing time for a scan will vary based on the number of items, document size,
and amount of content. Neat for Mac will optimize the scanned item for readability,
convert it into digital text, and parse it for key information. The accuracy of this process
depends on the quality of the item being scanned. For example, if the text on a receipt is
very light or the vendor name on a business card is in a highly stylized font, Neat for Mac
may not be able to read every detail clearly. Therefore, each scan should be reviewed for
accuracy.
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REVIEWING

In step 1, you selected a folder to scan your first item into. That folder is still selected. Once the
scan is complete, the item will appear on the right side of the screen. What you will see depends
on which view you are in and whether or not you have the Browse and/or Table panes open. If
you are in Item view, the scanned item appears in the Image Viewing pane in the middle of the
screen. The Thumbnail View pane displays a tiny image of the scanned item. If you have the Table
pane open, you will also see the scanned item in there as well, along with its name, description,
create and modify dates and any notes you have added.

4. Look at the Item Type dropdown menu (above the Thumbnail pane). Did Neat for Mac
correctly identify the type of item you scanned? If so, leave it as is. If not, reclassify the
item by choosing the correct type from the menu.

TIP: The Neat for Mac interface is color coordinated! The line beneath the toolbar indicates
what type of item is currently selected.  Receipts display a blue line; documents
display an orange line and contacts display a red line.

5. Want a closer look at the scanned item? Double-click on the item in the Item Viewing pane
to view it in the Item Editor. The item will open in a separate window, with editing and
zooming capabilities.

6. Click on the Icon View button at the top of the window to review the item in that view.
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WHAT’S NEXT?

So far, so good, right!? Neat for Mac has a lot more to offer as far as helping you track and
manage information and transform it into actionable, usable information. Where you go from here
depends on how you plan on using Neat for Mac. Links to a few topics of interest follow:

Scanner Settings

Organizing Your Items: Libraries, Cabinets, Folders & Subfolders

Working with Items

Exporting, Reporting & Printing
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The Neat for Mac interface  puts everything you need to use the program effectively and
efficiently on a single screen, including the following:

Navigate and view the contents of your Cabinet and Folders

Scan documents directly into a Folder

Use Smart Folders to view like items at a glance

Change the way you view items

Show/hide the Browse pane (not pictured)

Show/hide the Table pane (pictured)

Search for any  item in your Cabinet

Neat for Mac Interface

TIP: The Neat for Mac interface is color coordinated! In the screenshot above the blue line
beneath the toolbar indicates that the currently selected item is a receipt. For
documents, that line color is orange. For contacts, that line color is red.

In this section:
Neat for Mac Interface Buttons



11Chapter 3 The Neat for Mac Interface

3The Neat for Mac Interface

Neat for Mac Interface Buttons

On the main screen you will find one-click buttons to commands you will use most often as well as
a search tool to help you locate anything you’ve ever scanned into your cabinet.

Screenshot Command Description

Scan Begins scan.

Import
Allows you to import a PDF, Image or vCard
into Neat as well as bring in legacy Neat files
and Quicken Account information

New Allows you to create a new contact, receipt
or document without a related scan.

Delete Allows you to delete an item.

Editor Allows you to edit an item.

Email Allows you to send an item as an
attachment to an email.

Sync Animates to show sync in progress.

Item View

Displays the screen with the scanned image
visible in the top left of the screen, and the
receipt or document fields populated with
information at the top right of the screen.

Icon View

Displays thumbnail images for each item in
the folder you're viewing. In other words,
the thumbnails you see represent the items
in the folder you've selected from the
Cabinet. Additionally, the specific receipt or
document you've selected will be highlighted
with an orange border.

Report
View

Allows you to generate reports and to
access summary information. You can
combine items from multiple folders in any
given report.

Browse

Toggles a separate browsing grid for
intuitive searching. The Browse feature
aggregates and displays information about
your folder as a whole and for all fields,
including Amount, Date, and Vendor.



12 Chapter 3 The Neat for Mac Interface

3The Neat for Mac Interface

Screenshot Command Description

Table

Toggles a grid (table) in the bottom pane
containing the other receipt or document
rows visible for that folder, while the specific
row you've selected will be highlighted. Any
notes that you've created will display in the
table.

Search
Let’s you perform keyword searches to
locate your items quickly.

Neat for Mac exists to help free the information that’s trapped in your documents so you can
organize, store, secure and activate it. Neat's scanners and software solutions use patented OCR
and parsing technology to read and extract key information from your paper, so you can organize
it, export it, or securely store it in our easy-to-use database system.

In this section:
Neat Scanners

Getting Data Into Neat for Mac

Scanning Basics

Importing an Item

Printing to Neat for Mac

Creating a New Item
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Neat Scanners

Mobile Scanner The Mobile Scanner is a lightweight portable scanner designed
for scanning on the go. You can take it on the road and connect
to your laptop with a USB cable, allowing you to scan items
from any location using the Neat for Mac software.

Desktop Scanner The Desktop Scanner is a powerful, full-featured automatic
document feeder (ADF) scanner for scanning in multiple pages
automatically. This scanner offers faster scanning speeds,
double sided scanning, and an input tray that can be loaded
with multiple business cards, receipts and documents at the
same time.
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Getting Data into Neat for Mac

There are five ways to get data into Neat for Mac: scanning, importing, manual input, sending to,
or NeatCloud. Each method is described below:

SCANNING

Use the Mobile or Desktop Scanner to read and extract key information from a receipt, business
card or document. Benefit: reduce paper clutter and retain and organize important information.
See Scanning Basics for more information.

Scan
Button

IMPORTING 

Use the Import button to bring in key information from any PDF file or image already stored on
your computer. Benefit: reduce electronic clutter and retain and organize important information.

Import & New
Buttons

MANUAL INPUT

Use the New (Receipt, Contact, Document) button (pictured above) to manually add a new
receipt, contact or document. Benefit: retain and organize important information for which you
have no paper or electronic record. Alternatively, click the New menu, choose Item of Type and
select the type of new item you wish to create (pictured below).
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New > File of Type Menu

SENDING TO

Use the Neat printer driver to print from other applications (e.g. web browsers, email clients,
word processing) directly into Neat for Mac. Benefit: organize important digital information in
Neat.

NEATCLOUD

Use NeatCloud to add receipts, contacts or documents.

Scanning Basics

What Can I Scan?

You can scan any item containing information you want to retain and organize: receipts, business
cards or almost any document you wish to store electronically.

RECEIPTS

Scan receipts to track expenses. Neat for Mac finds key information on the receipt and organizes
it into common categories for you. You have full control over the scanned information and
categories and all of the scanned information can be searched. Scanned receipts can easily be
transformed into useful reports. 

BUSINESS CARDS

Scan business cards to create an instant contact list. Neat for Mac will find key information on a
business card and organize it into common contact list categories for you and all of the scanned
information can be searched.
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DOCUMENTS

Use the Neat mobile scanner or desktop scanner to scan any document and transform it into a
PDF. 

Any kind of document can be scanned - get creative!

Articles
Bank Statements
Bills
Contracts
Credit Card Statements
Estimates
Legal Documents
Nutritional Labels
Product Warranties
Recipes
Resumes

Also in this section:
How Do I Scan?

Scanner Settings

Understanding the Processing Queue

Reviewing a Scan
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How Do I Scan?

How Do I Scan?

Items can be scanned using the physical buttons on the scanner or the Scan command in Neat
for Mac. 

USING THE SCANNER BUTTON

Press the Scan button to scan an item into Neat for Mac. Neat for Mac will use its patented
OCR and parsing technology to read and extract key information from a scanned receipt or
business card and store it into common categories.

By default, the PDF button on your scanner does the same thing as the Scan button.
However, this can be customized in the Preferences > Scanning dialog box. See Setting
Preferences > Scanning Preferences for more information.

USING THE NEAT FOR MAC SCAN COMMAND

Click the Scan button in Neat for Mac to scan an item into the application. Neat for Mac will use
its patented OCR and parsing technology to read and extract key information from a scanned
receipt or business card and store it into common categories. Alternatively, choose Scan New
Item from the Scan menu or use the Command + K keyboard shortcut.

Click here to try your first scan!
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Scanner Settings

Neat for Mac scanner settings give you full control over every aspect of scanning. Using scanner
settings, you can do any of the following:

Choose to scan in color or black & white
Select a processing mode
Choose a scan destination
Choose to scan individual pages or combine several pages into a single document 
Change the document type (after scanning)

Each of these options is described in the next few pages.

Also in this section:
Choose to scan in color or black & white

Select a processing mode

Choose a scan destination

Choose to scan individual pages or combine several pages into a single document 

Change the document type (after scanning)
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Choosing Color or Black & White

Scan Options - Color Mode

You can choose to scan an item in color or in black & white. 

1. In the Folder Navigation pane, click on a folder. (This is where the new item will be stored.
You also have the option of creating a new folder.) 

2. Click Scan Options.

3. Choose the option you want: Black & White (Text), Black & White (Image) or Color.

4. Feed the item into the scanner and then click Scan. 

TIP: What's the difference between Black & White (Text) and Black & White (Image)?

Black & White (Text) is true black and white

Black & White (Image)  is gray scale
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Setting the Processing Mode

Scan Options - Processing Mode

The Scan Options menu (pictured above) offers three processing modes:

Mode Overview Example

Quick Scans just the image Use this mode when you need to scan an image quickly and
don't' need Optical Character Recognition (OCR). This mode
provides the fastest processing time since there is no OCR or
data extraction being done. However, this also means that
words in items scanned using this mode will not be
searchable.

Normal Analyzes just the first
page of a multi-page
scan

Using this mode means that only the very first page of a
multi-page document will incorporate OCR. The remaining
pages will be scanned as image only. This means that the
text on the first page of the document is searchable, but not
the text on the remaining pages.

Full Analyzes all pages of a
multi-page scan

This mode performs OCR analysis for every page. Although
this takes longer, it means that text on all pages of the
document are searchable.



21Chapter 4 Getting Items Into Neat for Mac: Scanning, Importing and Sending

4Getting Items Into Neat for Mac: Scanning,
Importing and Sending

Choosing the Scan Destination

Scan Options - Destination

The Scan Options menu (pictured above) offers three potential destinations for a scan:

Inbox Places the scan in the Inbox
Current Folder Places the scan in whatever folder is currently selected
Direct to PDF File Scans directly to a PDF file

TIP: For more information on scanning directly to a PDF file, see Scanning to a PDF.
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Scanning Separate Pages vs. Scanning Multi-Page

Scan Options - 
ADF Settings & Options

By default, Neat for Mac scans each item as a separate receipt, business card or document.
However, you scan multiple pages into a single receipt or document.

These instructions are for the Neat Mobile Scanner. Click here for instructions on scanning a multi-
page document using the Neat Desktop Scanner.

1. Click Scan Options.

2. Choose Combined - Item With All Pages.

3. Feed the item into the scanner and then click Scan. Neat for Mac will prompt you for each
page until you click Complete.

Changing the Document Type After Scanning

The document type can be changed (i.e. reclassified) after scanning if the program did not classify
an item correctly.

1. View the item.

2. Choose the correct item type from the Item Type dropdown menu. (Located above
Thumbnail view.)
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Item Type Dropdown Menu
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Scanning to a PDF

You can scan an item directly to a PDF file.

1. Click Scan Options.

2. In the Scan Options menu, under the Destination heading, choose Direct to PDF File.

3. Position the item in the scanner and click Scan. The Save As dialog box opens (pictured
below).

4. Type a name for the file in the Save As field.

5. Choose a location for the file from the Where dropdown.

6. Click Save.

Save As Dialog Box (collapsed)
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Save As Dialog Box (expanded Save As)

       

Save As Dialog Box 
(Where dropdown list showing)
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Understanding the Processing Queue

As you scan an item, a Scanning icon in the middle of the screen (pictured below) animates to let
you monitor the scan’s progress. Neat for Mac will optimize the scanned item for readability,
convert it into digital text, and parse it for key information. The processing time for a scan will
vary based on the number of items, document size, and amount of content. 

Neat Window During Scanning

When you are scanning multiple items, the queue area at the bottom of the Navigation pane
(pictured above) lets you keep track of how many items have been processed. This area says
"Scanning" while actively scanning and "Idle" when not actively scanning (pictured below).

Queue area when 
not scanning (idle)
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Reviewing a Scan

As an item is scanned, Neat for Mac will optimize it for readability, convert it into digital text, and
parse it for key information. The accuracy of this process depends on the quality of the item being
scanned. For example, if the text on a receipt is very light or the vendor name on a business card
is in a highly stylized font, Neat for Mac may not be able to read every detail clearly. Therefore,
each scan should be reviewed for accuracy.

1. Look at the Item Type dropdown menu (above the Thumbnail pane). Did Neat for Mac
correctly identify the type of item you scanned? If so, leave it as is. If not, reclassify the
item by choosing the correct type from the menu.

TIP: The Neat for Mac interface is color coordinated! The line beneath the toolbar indicates
what type of item is currently selected.  Receipts display a blue line; documents
display an orange line and contacts display a red line.

2. Want a closer look at the scanned item? Double-click on the item in the Item Viewing pane
to view it in the Item Editor. The item will open in a separate window, with editing and
zooming capabilities.

3. Click on the Icon View button at the top of the window to review the item in that view.

Importing an Item

Scanning is not the only way to capture data in Neat for Mac - you can also import from a PDF or
image file.

Import
Button

1. Click Import.

2. Browse to the folder containing the file you want to import.
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Importing an Item into Neat for Mac

3. Select the files you wish to import. (Use the Ctrl key to select multiple items.)

4. Click Open. The Analyzing icon (pictured below) animates to let you monitor the importing
progress. The processing time for importing will vary based on the number of items,
document size, and amount of content. Neat for Mac will optimize the scanned item for
readability, convert it into digital text, and parse it for key information.
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Importing an Item into Neat for Mac (Analyzing Icon)

5. When the import is complete, double-click on an item to review it.

Printing to Neat for Mac

Use the Neat printer driver to print from other applications (e.g. web browsers, email clients,
word processing) directly into Neat for Mac.  This feature lets you organize important digital
information in Neat.

1. Open the document you wish to send to Neat for Mac. (This could be a PDF, an image file,
Word document, etc.)

2. Choose Print. The Print dialog box opens.

3. Click the PDF button (bottom left of Print dialog box) and choose the appropriate item
type:

Add Contact

Add Document
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Add Receipt

Print to Neat

4. The Analyzing icon (pictured below) animates to let you monitor the importing progress.
The processing time for importing will vary based on the number of items, document size,
and amount of content. Neat for Mac will optimize the scanned item for readability,
convert it into digital text, and parse it for key information.
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Print to Neat (Analyzing Icon)

5. When the import is complete, double-click on an item to review it.

Creating a New Item

You can use the New (Receipt, Contact, Document) command to manually add a new receipt,
contact or document. This feature lets you retain and organize important information for which
you have no paper or electronic record.

1. Click New. 
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2. Choose the type of item you are creating:

Contact

Receipt

Document

The item is created.

3. Modify each of the fields as needed to provide details for the new item.

New Receipt Created

Working with the Neat Desktop Scanner

The Neat Desktop Scanner is an award-winning Automatic
Document Feeder (ADF) scanner. The patented paper input
tray lets you scan different kinds of paper - from small taxi
receipts to 2-sided legal documents - all in a single pass. Or
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insert up to 50 pages at once for lightning-fast batch
scanning. Key features include the following:

ADF scanner offers very fast scanning and reliability
across papers of different widths, qualities and
textures.

The patent-pending paper input tray design lets you
stack your receipts, cards and documents and scan
them all at once.  It handles up to 10 receipts, 10
business cards and 10 letter-sized documents, or you
can remove the tray to scan up to 50 pages of a
standard document.

The Neat ADF Scanner is FAST.  It can scan up to 25 pages per minute and Neat for Mac
software processes images in the background so there’s no delay between scans.

The scanner is duplex, allowing you to scan both the front and back of an item at the same
time.

Also in this section:
Duplex Scanning
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Duplex Scanning

Duplex Scanning

The Neat Desktop Scanner can scan BOTH sides of a two-sided document, receipt or business
card. 

TIP: Need to scan both sides of a paper item but you don’t have the Neat Desktop
Scanner? To scan a double-sided item (e.g. a document or a business card) with the
Neat mobile scanner, first scan one side of the item, and then flip it over and scan the
other side. Neat for Mac creates each side as a separate item in the application;
however, you can combine the two sides by using the Multi-Page Scanning option. To
learn how to do that, see Scanning a Multi-Page Document in Neat for Mac.

Scan Options - 
ADF Settings & Options

By default, Neat for Mac scans each item as a separate receipt, business card or document.
However, you scan multiple pages into a single receipt or document.

These instructions are for the Neat Desktop Scanner. Click here for instructions on scanning a
multi-page document using the Neat Mobile Scanner.

1. Click Scan Options.

2. Choose Combined - Item With All Pages.

3. Click Scan Options again.

4. Choose Double Sided.



35Chapter 4 Getting Items Into Neat for Mac: Scanning, Importing and Sending

4Getting Items Into Neat for Mac: Scanning,
Importing and Sending

5. Feed the item into the scanner and then click Scan.
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Neat for Mac stores all items in a secure digital database called the  Neat Library, which is stored
in the Documents folder on your Mac. A Neat Library consists of a Cabinet, Folder and subfolders
which you view when you work with your documents.  Within the cabinet you can create folders
and subfolders to organize related items. 

• Two folders are created automatically for new users upon installation: Business and Home.
You can rename or delete these folders as needed as well as create subfolders within
them. 

• Currently all your folders and subfolders will be organized under a cabinet called ‘My
Cabinet’.  

• You may create additional new folders and subfolders as needed. In the future, Neat will
provide ways to create multiple cabinets in the same Neat library as well. 

EXAMPLES OF FOLDER ORGANIZATION

Curious how others organize their cabinet folders? Check out our User Case Studies.

In this section:
Library Basics

Cabinet Basics

Folder Basics

Smart Folders
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Library Basics

The Neat Library is stored in your Documents folder on your hard drive. The Library consists of a
Cabinet and any Folders and Sub-folders that you will create under them. You can create multiple
libraries, and each library will consist of a Cabinet. 

Libraries are a good way to keep a large number of documents organized separately. For
example, a couple may want their business documents in separate libraries. You can also reach
the same level of organization by creating multiple folders in the same cabinet based on your
organizational needs. For example, a separate folder for Business A and Business B. 

In this section:
Creating a New Library

Opening a Library

Renaming a Library

Creating a New Library

1. Click the File menu.

2. Choose New > Library. The Save dialog box opens.

File > New > Library

3. Type a name for the library in the Save As field.
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Creating a New Library

4. Choose a location for the library using the Where dropdown.

5. Click Save. The library opens in a separate window.

Opening a Library

1. From the File menu, choose Open. The Open dialog box opens.

2. Navigate to and select the library you wish to open.

Open Library

3. Click Open. The library opens in its own window.

Renaming a Library

1. Double-click on the library icon. The library name is highlighted.

2. Type a new name for the library.
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3. Tap Return.

Cabinet Basics

Like a real-world file cabinet, the Neat Cabinet can contain folders to organize your documents,
receipts and contacts. The cabinet is stored within a Neat library which is stored in your
Documents folder Neat for Mac can remember one cabinet to open automatically on startup.  

Note: Currently, a library can contain only one cabinet. In the future, Neat will introduce a feature
that will allow a library to contain multiple cabinets. You can create an unlimited number of folders
and subfolders in a cabinet. 

By default, your cabinet’s name is Cabinet. To rename a cabinet, see Renaming a Cabinet.

In the Folder Navigation pane, click on the arrow next to the cabinet name to expand or
collapse that cabinet.

Navigation Pane
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In this section:
Renaming a Cabinet

Renaming a Cabinet

1. Double-click on the cabinet icon. The cabinet name is highlighted.

2. Type a new name for the cabinet.

3. Tap Return.

Folder Basics

Unlike your physical office, where you can “file” important papers on every surface, in Neat for
Mac all items must live in a folder. That said, you can be as organized - or as disorganized - as
you wish to be in Neat for Mac. If you want to place every item in a single folder, you can!
Alternatively, you can choose to completely master Neat for Mac file management by creating
folders and subfolders and consistently organizing items into those folders. 

Viewing Folder Content

To view the contents of a folder, simple click on it. Use the View buttons to change the current
view if necessary.

Also in this section:
Folder Best Practices
Creating a New Folder or Subfolder
Viewing Folder Content
Renaming a Folder
Deleting a Folder
Moving a Folder
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Folder Best Practices

Folder organization is subjective. There is no single right way to do it. What may seem flawless
and self-explanatory to one person may leave another completely baffled. There are, however, a
few tips that can help almost everyone:

Keep folder names short and meaningful
Adopt a consistent naming convention
Store like with like (receipts in one folder, canceled checks in another, etc.)
File as you go whenever possible
Folders are displayed alphabetically - use that to your advantage
Don’t fear depth - it’s OK to have subfolders inside of subfolders
Stick to your system

Examples

GOAL: TRACKING PERSONAL RECEIPTS CHRONOLOGICALLY BY MONTH

1. In the Folder Navigation pane, select the cabinet in which you wish to create a new
folder.

2. Do either of the following:

Click on the File menu and choose New Folder

Click on the New Folder button at the bottom of the Navigation pane.

There are two ways to create a new folder

3. Type the current year as the folder name and click OK.

4. Select the Year folder you just created.

5. Again, do either of the following:

Click on the File menu and choose New Folder
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Click on the New Folder button at the bottom of the Navigation pane.

6. Type January as the folder name and click OK.

7. Repeat steps 4 and 5 for each month.

TIP: Want to create the same exact folder structure for the previous or next years? Before
placing items in your new folder structure, copy the year folder. When pasting the
folder, rename it to the appropriate year.

GOAL: TRACKING BUSINESS EXPENSES BY CLIENT

1. In the Folder Navigation pane, select the cabinet in which you wish to create a new
folder.

2. Do either of the following:

Click on the File menu and choose New Folder

Click on the New Folder button at the bottom of the Navigation pane.

3. Type Clients as the folder name and click OK.

4. Select the Clients folder you just created.

5. Again, do either of the following:

Click on the File menu and choose New Folder

Click on the New Folder button at the bottom of the Navigation pane.

6. Type a client name as the folder name and click OK.

7. Repeat steps 4 and 5 for each client.

TIP: Need to track client expenses by specific project or purchase order number? Create
subfolders with those attributes within each client folder.

USER CASE STUDIES

Curious how others organize their cabinet folders? Check out our User Case Studies.
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Creating a New Folder or Subfolder

1. In the Folder Navigation pane, select the cabinet or folder in which you wish to create a
new folder.

2. Do either of the following:

Click on the File menu and choose New Folder

Click on the New Folder button at the bottom of the Navigation pane.

3. Type a name for the folder.
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Viewing Folder Content

You have four options for viewing folder content: Item View, Icon View, Report View and Table
View. To change between the views, use the Views buttons near the top right corner of the
screen (pictured below). 

View Description Screenshot (click to view larger)

Item View Displays the scanned
image alongside the
receipt or document
fields.

Item View

Icon View Displays a thumbnail
image for each scanned
item.

Icon View
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Report View Displays reports and lets
you view and generate
reports. You can combine
items from multiple folders
in a report.

Report View

Table Displays a list of items in
a table (grid) format at
the bottom of the
screen. Table view can
be displayed in Item,
Icon or Report view.

Click the Table button
to add the table to your
current view.

Item View with Table

Renaming a Folder

1. Double-click on the folder you wish to rename. The folder name is highlighted.

2. Type a new name for the folder.

3. Tap Return.

Deleting a Folder

1. In the Folder Navigation pane, click on the folder you want to delete. (To select multiple
folders, use the Command/Apple key.)

2. Do either of the following:

Click on the Edit menu and choose Delete Selected Folders

Click on the Delete Folder button at the bottom of the Navigation pane.

Drag the folder to the Trash icon and release it.
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There are two ways to delete a folder

3. Click Trash to confirm the deletion. 
If you do not wish to be prompted for future deletions, click in the Do not ask me again
checkbox before clicking on Trash.

Tip:  Your Folder has been sent to the Trash. To permanently delete the folder from Neat, see
Permanently Emptying all Trash Contents. 
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See also:
Retrieving a Deleted Folder
Permanently Emptying all Trash Contents

Retrieving a Deleted Folder

You can retrieve a deleted folder as long as you have not yet emptied the trash.

1. In the Folder Navigation pane, click on the Trash icon.

2. Drag the folder you wish to retrieve out of the Trash and into another folder.
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Permanently Emptying all Trash Contents

1. In the Folder Navigation pane, click on the Trash icon.

2. From the Neat menu choose Empty Trash.

3. Click Delete to permanently delete the contents in the Trash.
If you do not wish to be prompted for future deletions, click in the Do not ask me again
checkbox before clicking on Delete.

TIP: Once you have emptied the trash, you can no longer retrieve deleted items from the
trash.

Moving a Folder

Folders can be moved into other folders.

1. In the Folder Navigation pane, click on the folder you wish to move.

2. Drag the folder you wish to move into another folder and release.
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Smart Folders

Smart Folders appear at the bottom of the Folder Navigation pane, serving as shortcuts to saved
searches. To view the content of a Smart Folder, simply click on its icon. Two Smart Folders are
automatically added to a cabinet when it is created: All Receipts and All Documents. You can
create your own Smart Folders as well.

Smart Folder Name Description

All Receipts Displays all receipts in the cabinet

All Documents Displays all documents in the cabinet

Creating a Smart Folder

With Neat for Mac, you can create a Smart Folder of receipts or documents based on specific
criteria such as vendor name, category or date. Smart Folders are saved searches similar to
Smart Playlists in iTunes. Smart Folders are created using either the Browse function or the
Search function, as outlined below.

In this section:
Creating a Smart Folder Using the Browse Function

Creating a Smart Folder Using the Search Function

Creating a Smart Folder Using the Browse Function

1. Click the Browse button in the toolbar on the top right of the screen.

2. The Browsing pane opens near the top of the screen.
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Browse Pane

3. Clicking a field such as "Amount" or "Category" will display the number of items that fit
that category in the Detail pane on the right side of the Browse pane. Clicking on an item
in the Detail pane will display those items in the table at the bottom of the screen.  (Note
that you may use Clear to clear the search if necessary.)

Browse Pane with an Item Selected in the Detail Pane

4. To create a Smart Folder based on this criteria, click the Save button.

Naming a Smart Folder

5. Type a name for the Smart Folder and click OK.

TIP: For more information on browsing or searching for specific items, see Finding Items.
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Creating a Smart Folder Using the Search FunctionNew topic

1. Type a term such as Meals or Fuel in the Search bar at the top right. 

Searching in Neat

2. Items matching that criteria are displayed. (Note that you may use Clear to clear the
search if necessary.)

3. To create a Smart Folder based on this criteria, click the Save button.

Naming a Smart Folder

4. Type a name for the Smart Folder and click OK.

TIP: For more information on browsing or searching for specific items, see Finding Items.

Within a Neat cabinet you can create folders and subfolders to organize related items. 

Unlike your physical office, where you can “file” important papers on every surface, in Neat for
Mac all items must live in a folder. That said, you can be as organized - or as disorganized - as
you wish to be in Neat for Mac. If you want to place every item in a single folder, you can!
Alternatively, you can choose to completely master Neat for Mac file management by creating
folders and subfolders and consistently organizing items into those folders. 
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In this section:
Viewing Items
Editing Items
Moving or Copying Items Between Folders
Deleting & Retrieving Items
Sorting Items in List View
Finding Items
Combining Multiple Items
Splitting a Receipt
Customizing Columns
Creating a New Item without Scanning
Working with Images
Working with Contacts
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Viewing Items

To change between the three views, use the Views buttons at the top of the screen (pictured
below). Note that the Navigation pane remains on the left side of the screen for all views. Each
of these views is described in the table below.

View Description Screenshot (click to view larger)

Item View Displays the scanned
image alongside the
receipt or document
fields.

Item View

Icon View Displays a thumbnail
image for each scanned
item.

Icon View
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Report View Displays reports and lets
you view and generate
reports. You can combine
items from multiple folders
in a report.

Report View

Table Displays a list of items in
a table (grid) format at
the bottom of the
screen. Table view can
be displayed in Item,
Icon or Report view.

Item View with Table

Editing Items

You can edit items in Item View or in the Item Editor. Each detail is presented in its own field.
Some fields offer a dropdown menu of items.

Editing Items in Item View

1. In the Folder Navigation pane, navigate to the folder containing the item you want to edit.

2. Click the Item View button.

3. Click the Table button to display the grid.
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Item View (with the Table Showing)

4. In the table, click on the item you wish to edit. 

5. Using the Item Type dropdown list, modify the item type if necessary.

6. Modify each field as desired. Keep in mind the following:

Use the Tab key to move from field to field.

Depending on the item being edited, some fields may present as dropdown boxes.
These fields can be edited by choosing another item from the list OR by adding a new
item to the list. To add a new item to the list, simply type the new label.

Date fields can be modified by typing a new date (MM/DD/YYYY format) OR by clicking
on the calendar icon and choosing a date from the calendar.

7. Changes will be saved automatically. 

Editing Items in the Item Editor

1. In the Folder Navigation pane, navigate to the folder containing the item you want to edit.

2. In either Item View or Icon View, select the item you want to edit. 
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Item Editor

3. At the top of the screen, click on the Editor button. (Alternatively, from the Edit menu,
choose Open Ite-m Editor.) The item opens in the separate Item Editor window.

4. Using the Item Type dropdown list, modify the item type if necessary.

5. Modify each field as desired. Keep in mind the following:

Use the Tab key to move from field to field.

Depending on the item being edited, some fields may present as dropdown boxes.
These fields can be edited by choosing another item from the list OR by adding a new
item to the list. To add a new item to the list, simply type the new label.

Date fields can be modified by typing a new date (MM/DD/YYYY format) OR by clicking
on the calendar icon and choosing a date from the calendar.

6. Changes will be saved automatically. 
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Duplicating an Item

Individual items in a folder can be duplicated (copied) as needed.

1. In the Folder Navigation pane, navigate to the folder containing the item you want to
duplicate.

2. In the Table View pane, select the item you want to duplicate

3. From the Edit menu, choose Duplicate Selected Item. The item is duplicated and the
duplicate is placed in the same folder as the original.

4. Click OK.
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Moving an Item to Another Folder

Items in a folder can be moved to another folder as needed.

1. In the Folder Navigation pane, navigate to the folder containing the item you want to
move.

2. In the Table View pane, select the item you want to move and drag it to the desired
folder in the Navigation Pane. When you release the mouse, the item will be moved to the
new location.

In this image, a receipt from the Business Folder 
is being moved to the ABC Folder.

Deleting an Item

When an item is deleted, it is placed in the Trash (visible in the Navigation Pane) where it will
remain until the Trash has been permanently emptied. 

1. In the Folder Navigation pane, navigate to and open the folder containing the item you
want to delete.

2. At the top of the screen, click the Delete button.  (Alternatively, under the Edit Menu,
choose Delete Item.)
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3. When prompted, confirm the deletion by clicking Trash.

Tip:  Your item has been sent to the Trash. To empty the Trash, see Permanently Emptying All
Trash Contents. 

Also in this section:
Retrieving an Item

Permanently Emptying All Trash Contents
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Retrieving an Item

You can retrieve a deleted item as long as you have not yet emptied the trash.

1. In the Folder Navigation pane, click on the Trash icon.

2. Select the item you want to retrieve and drag it to the desired folder in the Navigation
pane. When you release the mouse, the item will be moved from the Trash to the new
location.

Permanently Emptying All Trash Contents

1. In the Folder Navigation pane, click on the Trash icon.

2. From the Neat menu, choose Empty Trash.
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3. Click Delete to permanently delete the contents in the Trash.

TIP: Once you have emptied the trash, you can no longer retrieve deleted items from the
trash.

Sorting Items in Table View

In Table View, items can be sorted by clicking on a column heading. Keep in mind the following:

Clicking on a heading for a column containing text sorts the rows alphabetically from A to Z.
Clicking a second time on that heading changes the sort from Z to A.

Clicking on a heading for a column containing dates sorts the rows from oldest to newest
date. Clicking a second time on that heading changes the sort to newest date to oldest
date.

Clicking on a heading for a column containing numbers sorts the rows from highest to
lowest. Clicking a second time on that heading changes the sort to lowest to highest.

Finding Items

Neat for Mac offers two options for finding items in your cabinets: Search and Browse. The
Search feature will return information for specific searches across all folders in a cabinet. The
Browse feature enables you to filter that search by your desired criteria. 

TIPS: Each library is its own separate entity; that is, you cannot search across multiple
libraries to find information. You may, however, search across all folders within a
single library. You could go to the Business Library to search across all folders within
it, and the search would not return any information from the Personal Library.
Likewise, you could go to your Personal Library and search across all folders within it,
but the search would not return any information from the Business Library.

Neat is fully integrated with the Apple Spotlight search utility. Spotlight can be used
for general searches across all Neat libraries.

Using Search

The Search feature is used to search for specific information across and within any folder(s). The
Search function can find all text on any item page, not just field values. You cannot search across
libraries; in other words, you may only search within one cabinet at a time. (Note that, while the 
Search feature will return information for specific searches across all folders in a library, it is the
Browse feature that will enable you to filter that search by your desired criteria.
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Search Field (Empty)

Search Field (With Options Displayed)

1. Type one or more search terms in the Search field near the top right corner of the Neat
for Mac window.

2. On the Search Bar (pictured above), choose where you want to search: All Folders, the
current folder or Trash.

3. To filter your search, use the browse feature.

TIP: To save the results of your search for future reference, click the Save button. Your
saved search displays under the Smart Folders heading on the left side of the screen.

Using Browse

The Browse feature aggregates and displays information about your folder as a whole and for all
fields, including Amount, Date, and Vendor. For example, if you wanted to know how many
receipts you have in the folder "Receipts 2008" that total between $2.00 to $4.99, you could
browse the folder for that information. If you have 1 receipt in your folder with a total between
$2.00 to $4.99, you would then see "(1)" next to that category: Amount: $2.00 to $4.99 (1)

1. Click the Browse button in the toolbar at the top right of the screen.

The Browsing pane will open as the topmost pane of your current view.

To deactivate the Browsing pane, just click the Browse button again.

If a Browse or Search (a browse is really a search behind the scenes) is currently
active, a search bar displays immediately below the browse window.

Browse Pane

2. Clicking a field such as "Amount" or "Category" will display the number of items that fit
that category in the Detail pane on the right side of the Browse pane.
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Browse Pane with an Item Selected in the Detail Pane

3. Clicking on an item in the Detail pane will display those items in the table at the bottom of
the screen.  (Note that you may use Clear to clear the search if necessary.)

TIP: To save the results of your search for future reference, click the Save button. Your
saved search displays under the Smart Folders heading on the left side of the screen.

Combining Multiple Items

You can combine multiple items into a single item.

1. In the Folder Navigation pane, navigate to the folder containing the items you want to
combine.

2. Select all of the items you wish to combine. (Hold down the Ctrl key to select multiple
images.)

3. From the Edit menu, choose Combine Selected Items. A separate window opens,
displaying thumbnails of all of the selected items.
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Combine Multiple Items

4. Drag the thumbnails into the order you wish to combine them. The leftmost item will be
used as the primary item. Pages from all other items will be appended in order from left to
right. 

If you are combining receipts, click in the Use combined total for currency fields
to add all of the receipt totals. (Otherwise, the total for the primary receipt is
used.)

Notes for all items will be combined.

5. Click Combine.

Splitting a Receipt

A receipt may contain multiple items that need to be expensed to more than one client or project.
 

1. In the Folder Navigation pane, navigate to the folder containing the receipt you want to
split.

2. Select the receipt you want to split. 

3. Duplicate the receipt.

4. Adjust the totals in each of the receipts.

Customizing Default Fields

After an item has been scanned, you’ll see its image on the right side of the screen and fields
populated with the item's information on the left side of your screen. All of the fields on the left
are able to be customized by using the plus/ minus signs. You can:

Add fields

Delete fields

Drag and drop fields to rearrange them
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Set default fields for each item type

Hover your mouse over the field name to bring up the plus/ minus signs next to any field (pictured
below).

Also in this section:
Adding a Field

Deleting a Field

Rearranging Fields

Setting Default Fields

Adding a Field

1. Point to the field below where you wish to add the new field and click on the Plus Sign
icon.

2. Choose an existing field from any of the submenus (Contact Fields, Document Fields,
Receipt Fields, System-defined Fields or User-designed Fields) or choose New Field to
create a new user-defined field.
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3. If you are creating a new user-defined field, provide a Field Label, a Field Name and a
Field Type and then click Create Field.

Deleting a Field

1. Point to the field you wish to move and click on the Minus Sign icon. If the field contains a
value, you will be prompted as to whether or not you wish to remove that value. If the
field does not contain a value, it will be removed immediately.
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2. Click Clear value and remove to remove the value and the field.

Rearranging Fields

1. Point to and click on the field you wish to move.

2. Drag the field to its new location. A black horizontal line (pictured below) indicates where
the item will be moved to.

3. Release the mouse.

Drag a field up or down to move it
(the line shows you where it will be moved to)
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Setting Default Fields

You can set the view as the default view for all future items (Contacts, Documents or Receipts) in
that item type.

1. View an item.

2. Add, delete and arrange fields as desired.

3. Click on the Plus Sign icon next to any of the fields.

4. Choose Use Fields Shown for all [Item Type].

5. Choose one of the following:

Use for this library only: to apply the field changes to all items of that type in the
current library only. (Note that previously customized items of the that type in that
cabinet will not be modified.)

Use for this library and others: to apply the field changes to all items of that type
in the current cabinet as well as any other libraries that have not been previously
customized.

Creating a New Item Without Scanning or Importing

You can use the New (Receipt, Contact, Document) command to manually add a new receipt,
contact or document. This feature lets you retain and organize important information for which
you have no paper or electronic record.

1. Click New. 
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2. Choose the type of item you are creating:

Contact

Receipt

Document

The item is created.

3. Modify each of the fields as needed to provide details for the new item.

New Receipt Created

Working with Images

There are many ways to work with a scanned image in Neat for Mac:
Zooming an image
Rotating an image
Cropping an image
Deleting an image
Printing an image
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Viewing an Image in the Item Editor

1. In the Folder Navigation pane, navigate to the folder containing the item you want to
edit.

2. In either Item View or Icon View, select the item you want to edit. 

3. Click the Editor button at the top of the screen. (Alternatively, choose Open Item Editor
from the Edit menu.

Item Editor

Also in this section:
Zooming an Image
Rotating an Image
Cropping an Image
Deleting an Image
Printing an Image
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Zooming an Image

1. View the image you want to work with in the Item Editor.

2. Use the zoom controls at the bottom of the window to zoom in ( + ) or zoom out ( - ) on
the image. Alternatively, use the Zoom In or Zoom Out commands on the View menu.

Zoom

Rotating an Image

1. View the image you want to work with in the Item Editor.

2. Under the Edit menu, choose Rotate Left or Rotate Right.
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Rotate

Cropping an Image

1. Double-click on the image you want to crop to open it in the Item Editor.

2. Click the Crop icon (center-top of the window). 

3. Use the crop controls to modify the image.

Deleting an Image

1. Double-click on the image you want to delete to open it in the Item Editor.

2. Click the Delete Page icon (top-right corner of the window). (Note that this delete icon will
only be available if you are looking at an item with a single image.

Printing an Image

1. View the image you want to print in the Item Editor.

2. Under the File menu, choose Print.
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3. In the Print dialog box, choose a printer and a Preset as needed.

Print

4. Click Preview to preview what the item will look like when printed. Use the scrollbar or
the Previous and Next buttons to move from page to page in the preview window. Use
the Zoom controls to zoom in ( + ) or out ( - ).

Preview

5. Click Print to print the item.

TIP: To print to a PDF file, click the PDF button in the Print dialog box, and choose Save as
PDF.

Working with the Address Book

Neat for Mac offers you complete control over your contacts, including the ability to scan business
cards and sync contacts with the Apple Address Book and/or your iPhone. For information on
scanning a business card, see Scanning Basics.
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In this section:
Emailing a Contact

Searching for a Contact

Syncing Contacts

Creating a New Contact Manually

Emailing a Contact

1. In the Folder Navigation pane, navigate to the folder containing the contact you want to
email.

2. Click Table.

3. Select the contact you want to email.

4. Click the Email button. A new, blank email opens.

5. Address and type the email using the usual methods. 
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Searching for a Contact

The Search field (top right corner) lets you quickly find a specific contact.

1. Type what you are looking for in the Search field.

2. In the Search bar, do one of the following:

To search for that contact within all of the folders in the current cabinet, click All
Folders. 

To search only in the currently selected folder, click the name of the folder. 

To search the trash, click Trash.

3. If multiple contacts are found, use the scrollbar at the bottom of the module to scroll
through the search results and select the contact.

Syncing Contacts

The Apple Address Book displays alongside your folders in the Navigation pane on the left side of
the screen. Simply drag and drop to copy!

Creating a New Contact Manually

You can use the New (Receipt, Contact, Document) command to manually add a new receipt,
contact or document. This feature lets you retain and organize important information for which
you have no paper or electronic record.

1. Click New. 
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2. Choose Contact. The item is created.

3. Modify each of the fields as needed to provide details for the new item.

New Contact Created

Neat for Mac gives you total control over - and complete flexibility with - your data. You can export
data to numerous formats, synchronize your contacts, create meaningful reports from your data
and print anything in your database. 

In this section:
Exporting

Reporting
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Printing
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Exporting

The Export menu lets you export to the following formats:

PDF
Image
CSV (Comma Separated Values)
Spreadsheet
Quicken
Tax Data

Also in this section:
Exporting to an Image Format
Exporting to PDF Format
Exporting to Comma Separated Values (CSV)
Exporting to Excel
Exporting to Quicken
Exporting Tax Data

Exporting to PDF Format

1. Navigate to and select the folder and/or items you want to export.

2. From the File menu, choose Export.
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Export to PDF

3. In the Export dialog box, click the PDF button.

4. Do one of the following:

To export only the items you currently have selected, click in the Selected items
only radio button.

To export all of the items in the current folder, click in the All items in  currently
selected folder radio button.

5. To restrict the export to specific dates, click in the Restrict dates from checkbox and
indicate the dates in the fields provided.

6. In the PDF  Options area, from the Quality dropdown menu, choose the desired image
quality setting. 

7. In the PDF Options area, if you want all items combined into a single PDF, click in the
Combine all items into single PDF checkbox.

8. Click Export.

9. Choose a folder location for the exported file and click Open. The file is exported to that
folder.
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Exporting to an Image Format

You can export receipts to a  JPEG, PNG or TIFF image file format.

1. Navigate to and select the folder and/or items you want to export.

2. From the File menu, choose Export.

Export to an Image Format

3. In the Export dialog box, click the Image button.

4. Do one of the following:

To export only the items you currently have selected, click in the Selected items
only radio button.

To export all of the items in the current folder, click in the All items in  currently
selected folder radio button.

5. To restrict the export to specific dates, click in the Restrict dates from checkbox and
indicate the dates in the fields provided.

6. In the Image Options area, from the Export dropdown menu, choose whether you want
just the first page or all pages exported.

7. In the Image Options area, from the File Type dropdown menu, choose the desired
image file type (JPEG, PNG or TIFF). 
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8. In the Image Options area, choose the desired image quality setting from the Image
Quality dropdown list. 

9. Click Export.

10. Choose a folder location for the exported file and click Open. The file is exported to that
folder.

Exporting to Comma Separated Values (CSV)

Exporting to CSV is a good way to get your data into an easy to use format that can be imported
into most other spreadsheet and database applications. Images will not be included in the
export. To control which fields are exported and in what order, add fields and sort or reorder the
columns shown in Table view.

1. Navigate to and select the folder and/or items you want to export.

2. From the File menu, choose Export.

Export to Comma Separated Values (CSV)

3. In the Export dialog box, click the CSV button.

4. Do one of the following:

To export only the items you currently have selected, click in the Selected items
only radio button.
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To export all of the items in the current folder, click in the All items in  currently
selected folder radio button.

5. To restrict the export to specific dates, click in the Restrict dates from checkbox and
indicate the dates in the fields provided.

6. In the CSV Options area, from the Text Encoding dropdown menu, choose the desired
encoding process (UTF-8 Encoding, ASCII Encoding or Western (Mac OS Roman Encoding).

7. Click Export.

8. Type a name for the exported file in the Save As field.

9. Choose a folder location for the exported file from the Where dropdown menu.

10. Click Save.

Exporting to a Spreadsheet

1. Navigate to and select the folder and/or items you want to export.

2. From the File menu, choose Export.
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Export to Spreadsheet

3. In the Export dialog box, click the Spreadsheet button.

4. Do one of the following:

To export only the items you currently have selected, click in the Selected items
only radio button.

To export all of the items in the current folder, click in the All items in  currently
selected folder radio button.

5. To restrict the export to specific dates, click in the Restrict dates from checkbox and
indicate the dates in the fields provided.

6. In the Spreadsheet Options area, choose one of the following options:

Workbook with table only, no images

Workbook with table and first page images
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Workbook with table and all page images

7. If you are exporting images, choose a size from the Image Size dropdown.

8. Click Export.

9. Type a name for the exported file in the Save As field.

10. Choose a folder location for the exported file from the Where dropdown menu.

11. Click Save.

Exporting to Quicken

1. Navigate to and select the folder and/or items you want to export.

2. From the File menu, choose Export.

Export to Quicken

3. In the Export dialog box, click the Quicken button.

4. Do one of the following:

To export only the items you currently have selected, click in the Selected items
only radio button.

To export all of the items in the current folder, click in the All items in  currently
selected folder radio button.
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5. To restrict the export to specific dates, click in the Restrict dates from checkbox and
indicate the dates in the fields provided.

6. In the QIF Options area, select a Quicken account name from the Quick Account
dropdown list. If you do not have any accounts listed in the dropdown yet, click Manage
Quicken Accounts and create a new account by doing the following:

Click the plus sign button ( + ). A new account is added.

Double click on the name of the new account to select it and type a better name
for the account

In the Type column, choose what type of account it is (Bank, Cash or CCard).

Click Save Changes.

TIP: You can import an existing Quicken Account by clicking on the Import button,
navigating to and selecting the QIF file and clicking Open.

7. By default, sales tax is not split. Click in the Split sales tax checkbox if you want sales tax
split.

8. By default, if items were already exported to Quicken, they will be skipped. If you don't
want these items skipped, uncheck the Skip items that were already exported to
Quicken checkbox.

9. Click Export.

10. Type a name for the exported file in the Save As field.

11. Choose a folder location for the exported file from the Where dropdown menu.

12. Click Save.

Also in this section:
Importing an Exported QIF into Quicken

Importing an Exported QIF into Quicken

1. Launch Quicken.

2. From the File menu, choose Import > QIF.

3. Navigate to and select the exported file.

4. Choose the Quicken account that you want the exported file imported into. When the
import is complete, the transaction will be in the Transactions to be Approved section of
the Quicken Register.

Exporting Tax Data

1. Navigate to and select the folder and/or items you want to export.

2. From the File menu, choose Export.
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Export Tax Data

3. In the Export dialog box, click the Spreadsheet button.

4. Do one of the following:

To export only the items you currently have selected, click in the Selected items
only radio button.

To export all of the items in the current folder, click in the All items in  currently
selected folder radio button.

5. To restrict the export to specific dates, click in the Restrict dates from checkbox and
indicate the dates in the fields provided.

6. In the TXF Options area, choose the Year and Quarter parameters for the data you wish
to export.

7. If you are exporting images, choose a size from the Image Size dropdown.

8. Click Export.

9. Type a name for the exported file in the Save As field.



87Chapter 7 Exporting, Reporting & Printing

7Exporting, Reporting & Printing

10. Choose a folder location for the exported file from the Where dropdown menu.

11. Click Save.

Reporting

Neat for Mac's Report View lets you view and create reports. You can combine items from multiple
folders in any given report.

Report View

Also in this section:
Report View
Creating an Expense Report
Printing a Report

Report View

Report View displays reports and lets you view and generate reports. 

You can combine items from multiple folders in a report.

You can restrict a report to specific dates by clicking in the Restrict dates from checkbox
and indicating the dates in the fields provided.

ACCESSING REPORT VIEW

You can access Report View in one of two ways:

Choose Report View from the View menu.

Click on the Report View button (pictured below) at the top of the screen.
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Report View
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Report Options (with Group dropdown menu)

Creating an Expense Report

An expense report typically contains expenses that an individual has incurred as a result of the
business operation. For example, if a business owner travels to another location for a meeting,
the cost of travel, the meals, and all other expenses incurred would be included on the expense
report. These expenses are considered business expenses and may be tax deductible.

1. Click the Report button.

2. From the Report Template dropdown menu, choose Expense Report.

3. To restrict the report to specific dates, click in the Restrict dates from checkbox and
indicate the dates in the fields provided.

4. To include only items that are currently selected, click in the Only include Selected Items
checkbox.

5. Click Report Options and choose the desired settings for your report.
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You can also choose whether you want only a summary table of field values, only
items, or both. If you choose to include a table, the columns of the expense report
table will be the same as the columns displayed in the table in the main Cabinet
window. To the right of these settings, you can choose to group a summary table
by a specific field if desired.

You can set the number of images per page and whether to include the field
values associated with each item.

You can choose to display page numbers by clicking in the Show Page Numbers
checkbox.

Report Options (with Group dropdown menu)

6. To include a cover page, click on the Cover Page tab and provide the information in the
fields provided. Note that you can use special coding in these fields, which will
automatically provide relevant information:

Coding Result
%date Today's date
%name Your name (take from the OSX Address Book)
%folder The name(s) of the folder(s) included in the report
%itemcount The total number of items in the report
%itemrange The date range used in the report
%templatename The Report Template used for the report

7. Click Apply.
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Creating a Phone List Report

A phone list report consists of first and last names as well as phone numbers.

1. Click the Report button.

2. From the Report Template dropdown menu, choose Phone List.

3. To restrict the report to specific dates, click in the Restrict dates from checkbox and
indicate the dates in the fields provided.

4. To include only items that are currently selected, click in the Only include Selected Items
checkbox.

5. Click Report Options and choose the desired settings for your report.

You can also choose whether you want only a summary table of field values, only
items, or both. If you choose to include a table, the columns of the expense report
table will be the same as the columns displayed in the table in the main Cabinet
window. To the right of these settings, you can choose to group a summary table
by a specific field if desired.

You can set the number of images per page and whether to include the field
values associated with each item.

You can choose to display page numbers by clicking in the Show Page Numbers
checkbox.
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Report Options (with Group dropdown menu)

6. To include a cover page, click on the Cover Page tab and provide the information in the
fields provided. Note that you can use special coding in these fields, which will
automatically provide relevant information:

Coding Result
%date Today's date
%name Your name (take from the OSX Address Book)
%folder The name(s) of the folder(s) included in the report
%itemcount The total number of items in the report
%itemrange The date range used in the report
%templatename The Report Template used for the report

7. Click Apply.

Creating a Tax Report

If you use Neat for Mac for tax purposes, it is a good practice to assign tax categories to receipts
and other tax-related documents that you scan. This can save you some time and work during
tax season.

The default value for the tax category field is “No form::Non-deductible.” Neat for Mac provides a
list of over 100 pre-defined tax categories commonly used in the US and Canada. You can select a
different tax category in either the Item view or the List view from the dropdown list. You can
select which tax categories are visible in your views. Please note that you cannot add, edit, or
delete tax categories because tax categories need to match IRS/CRA tax categories.

You can use tax categories to create tax reports to help you analyze and organize your financial
information for tax purposes. For example, you can create a tax report for all charitable donations
or you can create a tax report for all deductible medical expenses.
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1. Click the Report button.

2. From the Report Template dropdown menu, choose Tax Report.

3. To restrict the report to specific dates, click in the Restrict dates from checkbox and
indicate the dates in the fields provided.

4. To include only items that are currently selected, click in the Only include Selected Items
checkbox.

5. Click Report Options and choose the desired settings for your report.

You can also choose whether you want only a summary table of field values, only
items, or both. If you choose to include a table, the columns of the expense report
table will be the same as the columns displayed in the table in the main Cabinet
window. To the right of these settings, you can choose to group a summary table
by a specific field if desired.

You can set the number of images per page and whether to include the field
values associated with each item.

You can choose to display page numbers by clicking in the Show Page Numbers
checkbox.

Report Options (with Group dropdown menu)
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6. To include a cover page, click on the Cover Page tab and provide the information in the
fields provided. Note that you can use special coding in these fields, which will
automatically provide relevant information:

Coding Result
%date Today's date
%name Your name (take from the OSX Address Book)
%folder The name(s) of the folder(s) included in the report
%itemcount The total number of items in the report
%itemrange The date range used in the report
%templatename The Report Template used for the report

7. Click Apply.

Printing a Report

1. Click Report View.

2. Click Table.

3. In the table, click on the report you wish to print.

4. From the File menu, choose Print. Click Preview if you wish to see the document
onscreen before printing. Use the scrollbar or the Previous and Next buttons to move
from page to page in the preview window. Use the Zoom controls to zoom in ( + ) or out
( - ).

Preview Report

5. Click Print.
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TIP: To print to a PDF file, click the PDF button in the Print dialog box, and choose Save as
PDF.

Printing

Any item in your database can be printed.

1. View the image you want to print in the Item Editor.

2. Under the File menu, choose Print.

3. In the Print dialog box, choose a printer and a Preset as needed.

Print

4. Click Preview to preview what the item will look like when printed. Use the scrollbar or
the Previous and Next buttons to move from page to page in the preview window. Use
the Zoom controls to zoom in ( + ) or out ( - ).

Preview

5. Click Print to print the item.

TIP: To print to a PDF file, click the PDF button in the Print dialog box, and choose Save as
PDF.



96 Chapter 7 Exporting, Reporting & Printing

7Exporting, Reporting & Printing

Information is more abundant and easier to access than ever before. This is a great thing –
except that it’s also never been more difficult to stay organized. The overload of information and
the scattered places it resides creates “digital clutter.” Most digital clutter occurs because your
information comes in so many forms – emails, electronic documents, bookmarked web pages, e-
receipts – and lives in so many places: your computer, your smartphone, your shiny new tablet.
Trying to track down your important files is frustrating and wastes time. NeatCloud provides a
solution for digital clutter.

What is NeatCloud?

NeatCloud securely backs up your Digital Filing System, and allows you to add to it – or access it
– from anywhere. NeatCloud has been designed from the ground up to work in conjunction with
the NeatDesk and NeatReceipts digital filing systems.  

When your documents are in NeatCloud, they’re not only synchronized between your various
devices, they’re securely backed up on our servers. That means it’s safer to store something in
the cloud than on just your computer, and a broken computer or a lost phone no longer means
lost files. 

Using NeatCloud you can:

Instantly sync all of your Neat files across multiple devices

Automatically back up and protect all of your Neat files

View your Neat files from any Internet browser, from any computer

E-mail documents directly into your Neat account

Share individual files or folders with anyone you choose–the person you share with will be able
to view and comment on the documents you share

Have accounts with multiple users – two or more people can use the same account

What is Syncing?

Syncing (AKA synchronizing) is the automatic transmitting and updating of data between two or
more devices so they will all have the same exact files. That means when you scan an item at the
office, it’s uploaded to the cloud and instantly available on your home computer, your laptop, your
smartphone or tablet. 
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In this section:
Accessing NeatCloud

Syncing Your Neat Data

Backing Up Your Neat Data

Accessing NeatCloud

Signing Up for NeatCloud

Note: To use NeatCloud, you need to have an Active NeatCloud plan. Please go to
www.neat.com to learn more about NeatCloud and sign-up for a Free Trial. You can also
click on the 'Start Your Free Trial " button in the notification pop-up in Neat. 

1. Click Start Your FREE TRIAL Today. This will take you to the Neat store where you can
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view all of the NeatCloud plans and sign-up for a free trial. Once you have a NeatCloud
plan, you will turn activate Sync on the screen below.

2. To turn on Sync, click the On button. That’s it! Once you’re logged in and have sync turned
on, your files will automatically sync every time you launch your Neat software, then every
few minutes thereafter. You can also use the Sync button should you want to sync your
files manually.

3. Access NeatCloud from any web browser by logging in at https://cloud.neat.com

HOW LONG DOES THE INITIAL SYNC TAKE?

Syncing to NeatCloud is fast - but the amount of time it will take to sync for the very first time will

https://cloud.neat.com
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be based on the amount of data you are syncing. Subsequent syncs will be faster.

While your account is syncing, the percentage completed will display just under the Sync button.

Syncing Your Neat Data

The backbone of NeatCloud is the ability to sync your Digital Filing System with virtually every
piece of technology you own. That means when you scan an item at the office, it’s uploaded to
the cloud and instantly available on your home computer, your laptop, and virtually every other
piece of technology you own. All of this happens automatically, ensuring your files are always up
to date. 

1. Start Neat for Mac on your desktop computer.

2. Click the Sync button. (Note that, if this is the very first time you are doing this, you will
be prompted to turn the Sync feature on.)

3. Click On.

4. Click Save and Close. You will be prompted to sign in to your Neat account.
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5. Provide your username (email address) and password in the appropriate fields and click 
Sign in. (Uncheck the Remember this password in my keychain checkbox if you would
prefer to be prompted for your password each time you log in.) The Sync button will
display the percentage completed while syncing (pictured below).

6. That's it! Once you’re logged in and have sync turned on, your files will automatically sync
every time you launch your Neat software, then every few minutes thereafter. You can
also use the Sync button should you want to sync your files manually. 

HOW DO I STOP SYNCING TO ONE OF MY OFFICE COMPUTERS?

To temporarily stop syncing one of your computers with NeatCloud, simply go to Tools >  Sync >
Sync Settings to  turn it Off. Any changes made to your Neat data on any of devices will now
stop syncing with this computer. 

To permanently stop syncing one of your computers with NeatCloud, go to www.neat.com, sign
in, and click on your account name in the top-right corner of the screen. Select Product Keys &
Authorizations and then de-authorize the computer you want to stop syncing. 

Backing Up Your Neat Data

When your documents are in NeatCloud, they’re not only synchronized between your various
devices, they’re securely backed up on our servers. That means it’s safer to store something in
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the cloud than on just your computer, and a broken computer or a lost phone no longer means
lost files. It also means that a new computer or gadget can quickly access all of your Neat files –
just sign in to NeatCloud and your files will be there waiting! 

When your documents are in NeatCloud, they’re not only synchronized between your various
devices, they’re securely backed up on our servers. That means it’s safer to store something in
the cloud than on just your computer, and a broken computer or a lost phone no longer means
lost files. Despite its online nature, NeatCloud is private and secure. Neat doesn’t gather data or
peek at your files – your personal information remains visible only to you.

For step-by-step instructions on syncing for the first time, see Syncing Your Data.

Like file syncing, backup is an automatic feature of NeatCloud that requires no extra effort from
you. However, should you wish to manually back up your files, all you need to do is press the
Sync button. Your files are backed up whenever NeatCloud is synced. 

Note: NeatCloud only backs up files within Neat; it does not support backing up your
computer’s entire contents. 

The Neat for Mac Preferences dialog box lets you customize the program in a number of ways to
better suit your needs.

The General tab enables you to select Export Image Quality, Date Format and the default
Cabinet that opens whenever you start the system. You can also choose whether the
application should check for updates, send crash reports, and integrate with Spotlight.

The Scanning tab lets you select your active scanner and image settings. You can optimize
the images for smaller size or better quality by using the slider bar.

The Shortcuts tab lets you customize your keyboard shortcuts.

The Advanced tab lets you reset warnings and remove all cached images used for item
previews and reports.

In this section:
General Preferences

Scanning Preferences

Shortcut Preferences

Advanced Preferences

General Preferences

The General tab enables you to select Export Image Quality, Date Format and the default
Cabinet that opens whenever you start the system. You can also choose whether the application
should check for updates, send crash reports, and integrate with Spotlight.
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Preferences Dialog Box - General Tab

Changing the Export Image Quality

Note that choosing a lower image quality can reduce the size of PDF files created by dragging or
exporting an item.

1. From the Neat menu, choose Preferences.

2. Click the General tab.

3. Click on the Export Image Quality dropdown list and select the desired image quality.

4. Close the Preferences dialog box.

Changing the Date Format

Note that you must exit and then restart the application for changes to the date format to tale
place.

1. From the Neat menu, choose Preferences.

2. Click the General tab.

3. Choose the desired date format from the Date Format dropdown list. An example of how
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the date will appear will display to the right of the field.

4. Close the Preferences dialog box.

Changing the Default Library

The default library opens automatically when you launch the application. You can choose any of
your libraries  to be the default library. Doing so will not move your current default library.

1. From the Neat menu, choose Preferences.

2. Click the General tab.

3. Under the Default Library heading, click Change.

4. Navigate to and select the library you wish to make your default library.

5. Click Open.

6. Close the Preferences dialog box.

Scanning Preferences

The Scanning tab lets you select your active scanner and image settings. You can optimize the
images for smaller size or better quality by using the slider bar.
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Preferences Dialog Box - Scanning Tab

Choosing the Active Scanner

If you have multiple scanners, there is where you will choose which one you are currently using.

1. From the Neat menu, choose Preferences.

2. Click the Scanning tab.

3. Click on the Choose Scanner dropdown list and select the desired scanner.

4. Close the Preferences dialog box.

Changing how Scanner Buttons Behave

Your scanner has two buttons: Scan and PDF. You can customize how those buttons act when
pressed. For example, you could have one button scan in color and the other scan in black and
white text. 

1. From the Neat menu, choose Preferences.

2. Click the Scanning  tab.

3. Do one or both of the following:
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Click on the Scan button action dropdown and choose the desired action

Click on the PDF button action dropdown and choose the desired action

Preferences Dialog Box - Scanning Tab

4. Close the Preferences dialog box.



106 Chapter 9 Setting Preferences

9Setting Preferences

Shortcut Preferences

The Shortcuts tab lets you customize your keyboard shortcuts.

Preferences Dialog Box - Shortcut Tab

Advanced Preferences

The Advanced tab lets you reset warnings and remove all cached images used for item previews
and reports.
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Preferences Dialog Box - Advanced Tab

A clean, calibrated scanner is a happy scanner! 

Keeping your scanner clean is an important part of scanner maintenance. Dust and other
obstructions on the scanner lens can cause streaks on scanned images and potentially impact
the accuracy of the scanned images. The cleaning process will remove flecks of dust or small
pieces of paper that have been caught in the scanner, which will in turn improve the quality of
your scans.

The calibration process helps the scanner “see” correctly and therefore provide crisp accurate
scans by differentiating between black, white, shades of gray and other colors. Calibrating your
scanner is simple and quick. Neat for Mac may prompt you to calibrate the scanner during
installation; however you may occasionally need to recalibrate if scans appear faint or off-
balance.

Instructions for cleaning and calibrating your scanner are below.

In this section:
Cleaning the Neat Mobile Scanner

Calibrating the Neat Mobile Scanner

Cleaning the Neat Desktop Scanner
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Calibrating the Neat Desktop Scanner



109Chapter 10Scanner Maintenance

10Scanner Maintenance

Maintaining the Neat Mobile Scanner

A clean, calibrated scanner is a happy scanner! 

Keeping your scanner clean is an important part of scanner maintenance. Dust and other
obstructions on the scanner lens can cause streaks on scanned images and potentially impact
the accuracy of the scanned images. The cleaning process will remove flecks of dust or small
pieces of paper that have been caught in the scanner, which will in turn improve the quality of
your scans.

The calibration process helps the scanner “see” correctly and therefore provide crisp accurate
scans by differentiating between black, white, shades of gray and other colors. Calibrating your
scanner is simple and quick. Neat for Mac may prompt you to calibrate the scanner during
installation; however you may occasionally need to recalibrate if scans appear faint or off-
balance.

Instructions for cleaning and calibrating your Neat Mobile scanner are below.

In this section:
Cleaning the Neat Mobile Scanner

Calibrating the Neat Mobile Scanner

Cleaning the Neat Mobile Scanner

Cleaning the Neat Mobile Scanner

Two types of cleaning paper are included in the Welcome Kit: one dry and one wet. 

Dry The dry cleaning paper is a small, white, 'cottony' piece of paper that
resembles a dryer sheet. Always try this dry cleaning paper first.

Wet The wet (alcohol-based) cleaning paper is especially useful for scanners that
are producing very streaky images as it will help remove particularly stubborn
dust and paper particles. Only use the wet cleaning paper if you've already
tried cleaning with the dry cleaning paper and have not had optimal results.

USING THE DRY CLEANING PAPER

1. Feed the dry cleaning paper into the scanner, just as you would a receipt. 

2. In Neat for Mac, click the Scan menu.

3. Choose Clean Scanner.
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4. Click Clean to confirm.

NOTE: During the cleaning process, you will see a message that says “Please wait -
cleaning in progress” and the cleaning paper will move back and forth through
the scanner for approximately 25 seconds before being pulled through all the
way.

4. When cleaning is complete, you will be prompted to click OK to continue.

Important: Store the dry cleaning paper in the Welcome Kit for safe-keeping. 

USING THE WET CLEANING PAPER

Only use the wet cleaning paper if you've already tried cleaning with the dry cleaning paper and
have not had optimal results.

1. In Neat for Mac, click the Scan menu.

2. Choose Clean Scanner.

3. Click Clean to confirm.

NOTE: During the cleaning process, you will see a message that says “Please wait -
cleaning in progress” and the cleaning paper will move back and forth through
the scanner for approximately 25 seconds before being pulled through all the
way.

4. When cleaning is complete, you will be prompted to click OK to continue.

Important: Discard the wet cleaning paper. 

To Purchase Additional Wet Cleaning Paper

Go to the Neat Website and order a Scanner Maintenance Kit, which includes 6 sheets of alcohol
cleaning paper and 3 sheets of calibration paper!

http://store.neat.com/
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Calibrating the Neat Mobile Scanner

Calibrating the Neat Mobile Scanner

1. Remove the calibration paper from its special pocket in the Welcome Kit.

NOTE: Be certain to use the calibration paper, and not the cleaning paper. The
cleaning paper resembles a dryer sheet, while the calibration paper is a thin,
white piece of paper. If you can't find your calibration sheet, you can print a
new one by clicking Print Calibration Sheet in the Calibrate Neat Mobile
Scanner dialog box (pictured after step 2). As an alternative, if you can't print
from your computer, click Restore Default Calibration Values. 

2. Load the calibration sheet into the scanner as shown in the Calibrate Neat Mobile
Scanner dialog box.

3. In Neat for Mac, click the Scan menu.

4. Choose Calibrate Scanner.

5. Click Calibrate. An alert box will let you know when calibration is complete.

Important: Store the calibration paper in its special pocket in the Welcome Kit for safe-
keeping. 

TIP: If you still notice that scans appear faint or don't look quite right, you may repeat the
calibration process. 
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Maintaining the Neat Desktop Scanner

A clean, calibrated scanner is a happy scanner! 

Keeping your scanner clean is an important part of scanner maintenance. Dust and other
obstructions on the scanner lens can cause streaks on scanned images and potentially impact
the accuracy of the scanned images. The cleaning process will remove flecks of dust or small
pieces of paper that have been caught in the scanner, which will in turn improve the quality of
your scans.

The calibration process helps the scanner “see” correctly and therefore provide crisp accurate
scans by differentiating between black, white, shades of gray and other colors. Calibrating your
scanner is simple and quick. Neat for Mac may prompt you to calibrate the scanner during
installation; however you may occasionally need to recalibrate if scans appear faint or off-
balance.

Instructions for cleaning and calibrating your Neat Desktop scanner are below.

In this section:
Cleaning the Neat Desktop Scanner

Calibrating the Neat Desktop Scanner

Cleaning the Neat Desktop Scanner

Cleaning the Neat Desktop Scanner

Click here to watch a video on this topic.

1. Turn off the scanner and disconnect the power cord.

2. Dampen the provided cleaning cloth with isopropyl alcohol (95%). 

Do NOT use water. 

Do NOT use abrasive cleaners.

Do NOT spray isopropyl alcohol or any other solvent into the scanner or anywhere on
the scanner.

3. Open the scanner by pushing the lever down on the front right side (as shown in Figure 1
below).

http://www.neat.com/support/video-tutorials-and-user-guides/cleaning-your-adf-scanner-tutorial
http://en.wikipedia.org/wiki/Isopropyl_alcohol
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4. Clean the feed roller & paper pad. as follows:

Gently push the paper pad mechanism to the left and lift it gently until you feel
resistance. (Figure 2b) and then squeeze both sides of the paper pad mechanism and
gently pull it out. (Figure 2c)

Clean the paper pad mechanism. Be careful not to bend the metal tab. 

Wipe the feed roller from side to side and then rotate it. Repeat until its entire surface
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is cleaned. (Figure 2d)

Replace the paper pad mechanism. Be sure you hear the paper pad mechanism ‘click’
back into place.

5. Clean the lower glass imager by gently wiping over the length of the glass image. (See
Figure 2 above)

Be extremely careful not to catch the plastic tab with your cloth. 

Do NOT spray isopropyl alcohol or any other solvent into the scanner or anywhere on
the scanner.

6. Clean the upper glass imager by gently wiping over the length of the glass image. (See
Figure 2 above).

Be extremely careful not to catch the plastic tab with your cloth. 

Do NOT spray isopropyl alcohol or any other solvent into the scanner or anywhere on
the scanner.

Use extreme caution when cleaning around the paper sensor (the small plastic arm
just above the upper glass imager).

7. Wait for cleaned areas to dry completely BEFORE closing the scanner cover.

8. Close the scanner cover by pushing it back down until it snaps back into place.
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Calibrating the Neat Desktop Scanner

Calibrating the Neat Desktop Scanner

1. Remove the calibration paper from its special pocket in the Welcome Kit.

NOTE: Be certain to use the calibration paper, and not the cleaning paper. The
cleaning paper resembles a dryer sheet, while the calibration paper is a thin,
white piece of paper. If you can't find your calibration sheet, you can print a
new one by clicking Print Calibration Sheet in the Calibrate Neat Mobile
Scanner dialog box (pictured after step 2). As an alternative, if you can't print
from your computer, click Restore Default Calibration Values. 

2. Load the calibration sheet into the scanner as shown in the Calibrate Neat ADF Scanner
dialog box.

3. In Neat for Mac, click the Scan menu.

4. Choose Calibrate Scanner.

Calibrating Your Scanner

5. Click Calibrate. An alert box will let you know when calibration is complete.

Important: Store the calibration paper in its special pocket in the Welcome Kit for safe-
keeping. 
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TIP: If you still notice that scans appear faint or don't look quite right, you may repeat the
calibration process. 
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